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About Shelley Fishel 

Shelley Fishel has more than a dozen years’ experience in helping people to get more from their computers. 
After working for an IT training organization Shelley decided to ‘do her own thing’ when she realized 
the limitations of delivering standard courses.

“Why waste time and money on training people in areas that are not relevant to them? It’s common 
sense to invest that time and effort on what they really need.” 

That was the ‘light bulb moment’ and the IT Training Surgery’s unique approach has resulted in a growing 
business with a team of highly qualified IT trainers.

“If trainees get bored they forget most of what they learn. We like to offer a range of training approaches 
to suit different people and, most of all; we aim to make training fun!”

Shelley and her team have worked hard to achieve accreditation by the Learning and Performance Institute 
for the IT Training Surgery, as a recognized high quality provider of IT training,
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About Excel 2013 Core Intro

About Excel 2013 Core Intro
This user guide will take you through all the things you need to know when using Excel at a simple level.

You will learn how to:

•	 Get around Excel 2013
•	 Add text and numbers to spreadsheets
•	 Use Autofill to copy formula and create series
•	 Create a basic formula
•	 Use Average Minimum and Maximum
•	 Work with Worksheets
•	 And much more
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1	 First things first
1.1	 Starting Excel

Excel 2013 can be started from the Start Screen, the desktop or the Task Bar.

1.1.1	 The Start Screen (Windows 8.1)

Figure 1 – Windows 8 Start Screen

Click or Tap (if you are using a touch screen) on the Excel Tile

1.1.2	 The Desktop

Figure 2 – Excel Shortcut on the Desktop

Click on the Desktop Icon to launch Excel 2013
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1.1.3	 The Task Bar

Figure 3 – The Taskbar along the bottom of your screen

Click on the Excel Icon on the Task bar to launch Excel 2013

1.2	 The Excel Window

The Excel Window is arranged with the title of the workbook along the very top edge, the Quick Access 
Toolbar top left, the Minimize, Maximize and Restore icons top right and a grid in the middle, with 
vertical and horizontal scroll bars.

Figure 4 – The Excel Window

1.3	 The Ribbon

The Ribbon sits across the top of the screen and is made up of several Tabs. . Each Tab is arranged into 
groups and each group consists of icons that complement each other. 

1.3.1	 The Home Ribbon

Figure 5 – Home Ribbon

Here you will find the most commonly used icons, for example formatting, adding rows and columns, 
editing and finding things.
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1.3.2	 The Insert Ribbon

Figure 6 – Insert Ribbon

The Insert Ribbon is where you add a Pivot Table, Pictures, Charts and Shapes.

1.3.3	 The Page Layout Ribbon

Figure 7 – Page Layout Ribbon

Change the way the page is laid out using the icons on this Ribbon, including Margins, Orientation 
and Scaling.
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1.3.4	 The Formulas Ribbon

Figure 8 – Formulas Ribbon

The Formulas Ribbon has categories for all the formulas in Excel and this is where you will find Auditing 
and Named Ranges.

1.3.5	 The Data Ribbon

Figure 9 – Data Ribbon

If you want to Sort, Filter, Subtotal, analyze or bring data in from other sources – the Data Ribbon is 
where you want to be.

1.3.6	 The Review Ribbon

Figure 10 – Review Ribbon

Here you can Spell Check, Translate, add a Comment and Review the workbook with others.

1.3.7	 The View Ribbon

Figure 11 – View Ribbon

Change the way you are viewing the workbook here and customize the way your workbook is displayed.
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1.4	 Customizing the Quick Access toolbar

The Quick Access Toolbar is one of the most useful tools in Excel. There is a version of this for each of 
the Office packages so you can apply this lesson to Word, Excel, PowerPoint and Outlook.

The Quick Access Toolbar is situated at the top left of the screen above the File menu. It holds shortcuts 
that you use frequently. When you first load Excel there are only a few icons on the Quick Access Toolbar. 
You can customize the toolbar with the icons that you use most frequently.

The Quick Access Toolbar can be moved to sit below the Ribbon which then gives you plenty of space 
to keep adding icons.

1.4.1	 The Quick Access Toolbar at first

Figure 12 – Quick Access Toolbar

Here is the Quick Access Toolbar when you first load Excel. The only icons are:

•	 Save
•	 Undo
•	 Redo
•	 Touch – this changes the Ribbon giving more space between icons for use with a touch device
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1.4.2	 Adding Icons to the Quick Access Toolbar

Figure 13 – Add standard icons to the Quick Access Toolbar

Click the drop down arrow on the right of the Quick Access Toolbar and select from the list of frequently 
used icons. Whatever you select will be added to the toolbar. 

•	 If you would like the Quick Access Toolbar to be shown below the Ribbon pick ‘Show Below 
the Ribbon’

•	 For more shortcuts click More Commands

1.4.3	 Add an Icon with Right Click

Figure 14 – Add icons with right click

When you find an icon that you use all the time, you can save yourself a little time by adding it to the 
Quick Access Toolbar using the Right Mouse button. 
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1.4.4	 More Commands

Figure 15 – Add more commands to the Quick Access Toolbar
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There are hundreds of icons in Excel that can be added to the Quick Access Toolbar. As we all work 
differently we will have different requirements. 

•	 Click the Drop down to the right of the Quick Access Toolbar
•	 Select More Commands
•	 Choose from the different selections of icons available.

1.	 Here is a drop down list of different categories of icons, have a look through what is available.
2.	 The column on the Left shows the available icons in the category displayed – double click an 

icon to move it across to the Right hand column
3.	 The column on the Right shows the icons currently on the Quick Access Toolbar 
4.	 You can move the icons up and down the order with these spinners
5.	 Click OK when you are done

1.4.5	 Show below the Ribbon

Figure 16 – Show the Quick Access Toolbar below the Ribbon

Here I have clicked Show Below the Ribbon and added the New document icon and the Print Icon

1.4.6	 Remove an icon from the Quick Access Toolbar

Figure 17 – Remove Icons you no longer require

If you want to remove one of the frequent Icons, you can remove the tick from the drop down list and 
the icon will disappear.
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1.4.7	 Right Click to remove an Icon

Figure 18 – Use Right Click to modify the Quick Access Toolbar

Just like adding, you can also right click to remove an icon from the Quick Access Toolbar.
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1.4.8	 Use More Commands To Remove An Icon

Figure 19 – More Commands – remove or move icons around

1.	 Select the icon you wish to remove in the right hand column
2.	 Click Remove
3.	 Click OK

1.5	 Customizing the Ribbon

In Excel 2013 you can customize the Ribbon itself. This means you can have a whole ribbon tab with 
your own icons and groups of icons, or you can just change one of the pre-set Ribbon tabs to suit.

1.5.1	 Customize the Ribbon

1.	 Click File
2.	 Click Options
3.	 Click Customize the Ribbon

Figure 20 – Excel Options
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Figure 21 – Customise the Ribbon

You will now see two columns, on the left are the available icons that can be added to the Ribbon (1) 
On the right are the different Ribbon tabs (2) and groups of icons (3).

Figure 22 – Choose the commands group to add commands from

You can choose commands from the list of Popular Commands or from one of the other drop 
down options.
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1.5.2	 Create a New Group on an Existing Ribbon Tab

Figure 23 – Create a new group of icons

1.	 Click on the Ribbon you wish to customize
2.	 Click New Group
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1.5.3	 Rename the new group

Figure 24 – Rename a group of icons

1.	 Select the New Group (Custom)
2.	 Click on Rename
3.	 Type in your new name
4.	 Click OK
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1.5.4	 Add Icons to the New Group

Figure 25 – Add icons to the new group

1.	 Click on the icon you want to add from the list on the left
2.	 Click Add 
3.	 The icons now appear in the group you selected

When you have finished adding icons, click OK to go back to Excel.
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1.5.5	 See the Group on the Ribbon

Figure 26 – New Group on the Ribbon

My new group Columns and Rows is now on the far right of the Home Ribbon.

This means that you can customize one or two Ribbon Tabs with your favorite icons so that they are 
always there at your fingertips.

1.5.6	 Create a new Ribbon Tab

Figure 27 – Create a new Ribbon

If you want to create a brand new Ribbon Tab rather than modify an existing one, click New Tab

1.5.7	 Rename the Tab

Figure 28 – Rename the New Tab

1.	 Click on the New Tab (Custom) 
2.	 Click on Rename
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1.5.8	 Type a Name for the New Ribbon

Figure 29 – Add the name for the tab

1.	 Type in the name 
2.	 Click OK
3.	 Then rename the New Group (Custom) as above
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1.5.9	 Now Add Icons to the New Ribbon And Group

Figure 30 – Keep adding icons

Find the icons you want and add them to the group you renamed – I am adding my favorite Sorting 
and Subtotal features.

1.5.10	 See your new Ribbon

Figure 31 – My New Ribbon – called Shelley

Here is my new Ribbon.
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1.5.11	 Moving Tabs around

Figure 32 – Use up and down arrows to change the order

1.	 Click on the Ribbon you want to move
2.	 Click the Move Up button or the Move Down Button
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1.5.12	 Remove a tab

Figure 33 – Remove a Ribbon Tab when you no longer need it

1.	 Click on the tab you want to remove
2.	 Click Remove

1.6	 Using Zoom
When working with a large worksheet, you may not be able to see everything on your screen. This is 
because when maximized to 100% many worksheets are larger than the screen. To view more or less of 
the detail you can use the Zoom tools.

1.6.1	 Zoom Slider

Figure 34 – The Zoom Slider

The Zoom slider sits at the bottom right of the screen. To change the magnification drag the slider right 
to enlarge and left to reduce. You can also click on the plus and minus signs.

http://bookboon.com/


Download free eBooks at bookboon.com

Excel 2013 Core: Intro

32 

First things first


1.6.2	 Show the Zoom dialogue box

Figure 35 – See the Zoom Slider dialog box

Click on the 100% which is in the bottom right corner
The Zoom box will appear where you can change the magnification or fit selection.

Use the Zoom group on the View Ribbon

Figure 36 – Use the Ribbon

Zoom – this opens up the Zoom dialogue box
100% – returns the worksheet to 100% magnification if you have changed it
Zoom to Selection – this will zoom the current selection in view
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1.7	 Assigning shortcut keys using The Alt Key

Office 2013, including Excel 2013, comes with built in keyboard shortcuts that you access via the Alt 
Key. Press the Alt Key and some letters and numbers pop up on screen. Now press those letters and 
numbers in sequence and you have a keyboard shortcut.

However, if you wish to create your own keyboard shortcut, you can add your shortcut to the Quick Access 
Toolbar and then when you hit Alt, a number appears – hey presto you just customized a keyboard shortcut.

1.7.1	 Add Your Icon to the Quick Access Toolbar

Figure 37 – Add icon with right click

Right click and then click on Add to Quick Access Toolbar
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1.7.2	 Here is my Quick Access Toolbar

Figure 38 – Modified Quick Access Toolbar

My new addition shows up on the far right in position number 6

1.7.3	 Press Alt

Figure 39 – Press the Alt Key to get visual shortcuts

When I press the Alt Key – the numbers which indicate the position of the icon on the Quick Access 
Toolbar appear. 
Now to use my Subtotal icon I just press 6.
So Alt + 6 is my new keyboard shortcut for Subtotals. 
Alt + 1 would be Save, Alt +2 would be Undo etc.

1.7.4	 Change the order

Figure 40 – Change the order of icons

1.	 Click File
2.	 Click Options
3.	 Click Customize the Quick Access Toolbar
4.	 In the list on the right, select the icon you want to move up or down
5.	 Click on the Move Up or Move Down arrows to change the position
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1.8	 Adding values to workbook properties

Workbook Properties allow you to add information about the Workbooks. Add an Author, a Title, Tag 
the workbook so that it can be found easily.

1.8.1	 Where do I find Properties?

Figure 41 – The Properties Panel

Click on File and then see Info
Properties are displayed on the right

1.8.2	 Add an Author

Figure 42 – Add another author or change the author

You can type the name of another person to have them the Author or you could pick them from a list 
in the address book.

Properties will show you when the document was first created, last printed or modified and who the 
Author is.
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1.8.3	 Document Panel

Figure 43 – See the Document Panel to add properties

You can also edit Document Properties directly in a Document Panel above the workbook. Click Show 
Document Panel to turn it on.

Figure 44 – The Document Panel

Here are the document properties for the Coffee Sales workbook. 

1.8.4	 Close the document information panel

Figure 45 – Close using the x on the right

Click on the X in the top right hand corner of the document panel to switch it off.
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2	 Saving
2.1	 Saving a Workbook for the First Time

There are several ways to save your work in Excel 2013. The icon on The Quick Access Toolbar, The File 
Menu and the Keyboard.

2.1.1	 Saving your workbook for the first time

Figure 46 – Name the workbook and set the location

When you save the workbook for the first time, you will be prompted for the location you want to save 
the workbook to, and for the name of the workbook.

2.1.2	 Save a Workbook Quick Access Toolbar Method

Figure 47 – Use the Save icon

1.	 Click the Save Icon on the Quick Access Toolbar
2.	 Navigate to the folder where you want to save the workbook
3.	 Type a name for the workbook
4.	 Click Save
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2.1.3	 Save using the Keyboard

Press Control + S

This keyboard shortcut will save the workbook just like clicking on the icon. You will be prompted in 
the same way.

2.1.4	 Saving with File As

Figure 48 – Save as can do many things

1.	 Click File
2.	 Click Save As (2)
3.	 Click Computer (if you are saving your document locally) (3)
4.	 Select the folder from the list on the right (4)
5.	 If you cannot see the folder you want to use, you can click Browse to navigate to the one 

you want (5)
6.	 Type a name for the workbook
7.	 Click Save

2.2	 Saving your Workbook Once it has a Name

When you save a workbook that has already been saved before, all you are saving is any work you have 
added to it since it was last saved.

You can use any of the Save options to save your work. Use the Save Icon, Control + S or File -Save As.

If you want to save a copy of your workbook in another location then you will need to use File and Save 
As so that you can pick the folder where you wish to save the workbook.
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2.3	 Save as different file formats

Most of the time, you’ll probably want to save your workbooks in the current file format (.xlsx). However, 
sometimes you might need to save your spreadsheet as a PDF, a text file or an XPS file. Bear in mind 
that if you save your spreadsheet in another format, some data and features may not be supported and 
so will not be saved.

If you need to save your work in a format that an older version of Excel can open, then any features 
which are new in Excel 2013 may not be available in the older version.

2.3.1	 Save As

Figure 49 – use different formats for different jobs

1.	 Click File
2.	 Click Save As
3.	 Navigate to the folder location where you want to save the workbook
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2.3.2	 Decide on the Type of File

Figure 50 – There are many different types of file to choose from

1.	 Click Save as Type
2.	 Select the type of file you wish to create
3.	 Type a name for your file
4.	 Click Save

Get “Bookboon’s Free Media Advice” 
Email kbm@bookboon.com

See the light! 
The sooner you realize we are right, 
the sooner your life will get better!

A bit over the top? Yes we know! 

We are just that sure that we can make your  
media activities more effective.
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2.4	 Saving Files to remote locations

Office 2013 is a stand-alone product and also part of Office 365. You can save your files to different 
locations other than your local computer or your workplace network.

Office 365 comes with Onedrive for Business and Sharepoint. If you are using a stand-alone version of 
Office and you have a Windows Live or Microsoft Account you also have a personal One Drive storage 
location in the cloud.

2.4.1	 Save to OneDrive

Figure 51 – Save online to OneDrive

1.	 Click File
2.	 Click Save As
3.	 Select the OneDrive 
4.	 Select the folder where you want to save your workbook
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2.4.2	 Save to SharePoint

Figure 52 – Save online to a company SharePoint site

1.	 Click File
2.	 Click Save As
3.	 Click on the Sharepoint icon with the organization’s name
4.	 Select the folder to store your workbook in from the recent folder list, or click Browse to 

find the folder you want to use

2.4.3	 Save to your Personal Folder on the SharePoint Site

Figure 53 – Save to your personal folder on the company SharePoint

Follow the steps above and then select User’s OneDrive @your organization – in my case Shelley Fishel’s 
OneDrive@theittrainingsurgery

Navigate to the folder where you want to save your workbook
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2.5	 Maintaining backward compatibility

When newer versions of Office programs come out, there is new functionality which is not available 
in the older versions. Specifically, if you are working with someone who is still using Office 2003 then 
you will have issues because the file format changed with Office 2007 which is the release that followed 
2003. In later versions, new features keep being added so it becomes necessary to save the workbook in 
a 2003 friendly way. This is called Compatibility Mode.

You can set your workbooks to be saved in this mode all the time, however be aware that you will lose 
functionality. Alternatively, you can save workbooks individually if you know you need to send them 
to someone with the older version.

2.5.1	 Compatibility Mode

Figure 54 – Look for Compatability Mode at the top of the screen

When you have a file that has been saved in compatibility mode it will tell you at the top of the screen.
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2.5.2	 To save in Compatibility Mode

Figure 55 – Change the Save as type to save in Compatibility Mode

1.	 Click File
2.	 Click Save As
3.	 Navigate to the folder where you wish to save the workbook
4.	 Type a name for your file
5.	 Change the Save as type to Excel 97-2003 workbook
6.	 Click Save
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2.5.3	 Save all files in Compatibility Mode

Figure 56 – Set Compatibility Mode as the default setting

1.	 Click File
2.	 Click Options
3.	 Click on Save
4.	 Change the Save files in this format box to Excel 97–2003 
5.	 Click OK

Whenever you save a workbook in the future, it will be saved in Compatibility Mode once you change 
this setting.

2.5.4	 Convert an Excel 97–2003 file to a later version

Figure 57 – Convert your older files to get the most up to date functionality

If your file is in Compatibility Mode you will see the Convert button in the Backstage View. 

1.	 Click File
2.	 Click Convert

Note the explanatory text that mentions that the file will be converted and that this may result in 
layout changes. 
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3	 Backstage View
3.1	 The Backstage View

In Excel 2003, to change any of the standard Excel options, you would have needed to click on the Tools 
Menu then select Options. In Excel 2007 you would have clicked on the Office Button in the top left of 
the screen and selected Excel Options from the bottom of this menu.

In Excel 2010 this changed with the reintroduction of the File Menu and Options moved here. It is called 
the Backstage View because this is where all those things that get controlled in the background live.

3.1.1	 The Backstage View – Showing the Info Panel

Figure 58 – Backstage View – Info Panel

Click on the File Menu
You are now in the Backstage View – in the image above, you can see the Info screen showing:

•	 Protect Workbook – Control what people can change and what they cannot change when 
you send them your workbook

•	 Check for Issues – Check if there is anything in the workbook that will stop it performing at 
its best and check for compatibility issues 

•	 Versions – you can get back to a recently saved version of the workbook – these are created 
when you auto save. Handy if you mess up!

•	 Browser View Options – control how your workbook will behave when displayed in a 
browser on a SharePoint site

•	 Properties – set the Properties for the workbook, such as Author, or see when it was created 
and edited
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3.2	 Excel Options

Changes to many of Excel’s options are found on the Options panel. Here you can change:

General Options – default font, what you can see etc
Formulas – how Excel calculates and other things realting to how Formulas work
Proofing – Auto Correct Options and what Spell Check should look out for
Save – the file format to save in, where auto saves are kept, how Auto recover works
Language – set the language here
Advanced – Editing options, More options than there is room for here!
Customize Ribbon – here you can customize the Ribbon and create new Ribbon Tabs.
Quick Access Toolbar – customize the Quick Access toolbar 
Add Ins – View and Manage Add Ins – extra programs that compliment Excel
Trust Center – control privacy settings
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4	 Share via Backstage View
4.1	 Share Via Email

When working in Excel you may need to share your workbook with someone who is not on your team, 
a client or a colleague. In this instance you may wish to email the workbook/spreadsheet or send it for 
shared review. You might also wish to Present it On line or Invite Others to share it with you.

4.1.1	 Share via Email

Figure 59 – Share via email from within Excel 2013

1.	 Click the File Menu
2.	 Click Share
3.	 Select Email
4.	 Then decide which option you wish to use

•	 Send as Attachment – starts up Outlook and attaches the workbook to a new email message
•	 Send a Link – starts up Outlook and puts a link to the file in the body of the message
•	 Send as Adobe PDF – this will appear if you have Adobe Acrobat Standard or Professional 

installed on your machine
•	 Send as PDF – you can send your workbook as a PDF even without a pdf program on your 

machine, so pick this one if that is the case for you
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•	 Send as XPS – XPS is a document file format that allows you to save your documents/
spreadsheets electronically and once saved, you cannot edit them – just like once you have 
printed a piece of paper you cannot change what is printed. You can send your spreadsheet 
as an XPS file. The person who receives it will need an XPS viewer to be able to read the 
document

•	 Send as Internet Fax – you can send your document via Internet Fax – however you will 
need a Fax Service Provider to do so

4.2	 Invite People to Share

Share your workbooks with other organization by inviting them. This option sends them an email with 
a link to an on line version of the file – that is so long as the file is saved on line.

4.2.1	 Invite People – Locally Saved Workbook

Figure 60 – Invite people to share

1.	 Click File
2.	 Click Share
3.	 Click on Invite People

You will need to save the workbook to the Cloud in order to Invite People to share it with you.
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4.2.2	 Invite People – Workbook stored on OneDrive

Figure 61 – Share via OneDrive

1.	 Click File
2.	 Click Share
3.	 Click on Invite People
4.	 Start to type the name of the person you want to share with
5.	 Select them from any list that pops up
6.	 Type a message telling them why they are receiving the file
7.	 Click Share
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4.3	 Open a Shared Workbook

When you receive an email telling you that a colleague has shared a workbook with you, you will want 
to open it. There will be a link in the email. When you click on the link,. the workbook will open up in 
a browser.

4.3.1	 Open a Shared Workbook from a link

Figure 62 – The email you receive when someone shares a workbook with you

Click on the name of the file which is in light blue big letters

4.3.2	 The Shared Workbook

Figure 63 – Open up in Excel Online

The workbook opens up in a web browser using Excel Online. 
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4.3.3	 Edit in Excel or Edit in Web App

Figure 64 – Choose how to edit the workbook

Edit the workbook in the Excel Web App on line or launch the full Excel Application on your desktop.

This workbook is in a shared location and can be worked on by only one person at a time.

Ensure your next performance management 
meetings run like a dream! Full trial FREE for 10 staff.

LEAD WITH 
CLARITY AND 
CERTAINTY

A short cut for managers to 

the most effective personal 

development plans and 

information that will quickly 

boost employee motivation, 

performance and results.

GET MY FREE TRIAL

Amy, let’s just 
discuss these action 

points
Spot on - I’m all 

fired up!! Looking 
forward to next 

quarter

Can’t believe 
this only took me 

5 minutes

Awesome! That 
nails it for me...

a review with Performance Review Pro
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5	� Create Worksheets 
and Workbooks

5.1	 Creating new blank workbooks

In Excel 2013 data is added to Worksheets, which in turn live inside Workbooks. Workbooks can be 
made up of just one single worksheet or of many. You can add and delete worksheets from a workbook 
quite easily. 

5.1.1	 To create a new blank workbook from the Start screen

Figure 65 – Start with a blank workbook

Click on the Excel shortcut on either your desktop, the task bar, the Windows Start screen or the Start 
menu
A window like the one in the picture will pop up. 
Click on Blank Workbook 

5.1.2	 A new blank workbook using the keyboard

When you are in Excel, you can start a new workbook by pressing the Control key and the letter N to 
create a new workbook
Control + N

5.1.3	 Create a New workbook from the Quick Access Toolbar

Figure 66 – use the Quick Access Toolbar

If you have the icon for New Workbook on the Quick Access Toolbar simply click on it to create a 
new book.
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5.1.4	 Create a New Workbook from the File Menu

Figure 67 – From the File Menu

1.	 Click the File Menu
2.	 Click New
3.	 Select Blank Workbook

5.2	 Creating New Workbooks Using Templates

Excel comes with many built in templates which can speed up your editing time. 

5.2.1	 Create a Workbook from a Template

Figure 68 – create a new workbook from a template

1.	 Click File
2.	 Click New
3.	 Select the template you want to use from those displayed
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5.2.2	 Search for a Template

Figure 69 – search for a template online

In Excel 2013 you can search for many more sample templates on line if the local ones do not meet your 
needs. I want to create an Invoice template
Click on the Invoice shortcut under the search bar at the top of the window.

5.2.3	 Excel will bring you a list of templates to match your search

Figure 70 – see a selection of templates that match your search
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5.3	 Changing worksheet order

If the worksheets in your workbook are not in the right order, you can drag and drop them into the 
order you need.

Move worksheets around

Figure 71 – move a worksheet around

I would like to place the Coffee Sales worksheet at the front of the tabs

1.	 Click and drag – you will see a little arrow and a picture of a page 
2.	 Drop the worksheet in the location you require.

Figure 72 – in its new position

Hey presto!

Contact us to hear more 
kbm@bookboon.com

Do your employees receive 
the right training?
Bookboon offers an eLibrairy with a wide range of 
Soft Skill training & Microsoft Office books to keep 
your staff up to date at all times.
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5.4	 Move or copy to a different workbook

5.4.1	 Move or copy to a different workbook

Figure 73 – decide where you want to place the worksheet or the copy

1.	 Follow the same process as before:
2.	 Right click on the sheet tab you wish to move or copy
3.	 Click on Move or Copy 
4.	 In the dialog box that pops up select where you want to move the worksheet to (1)
5.	 Select where you want the worksheet within the workbook (2)
6.	 If you want a copy, tick the Create a copy box (3)
7.	 Click OK

Figure 74 – when creating a copy make sure to tick the box

1.	 Select where you want the copy to be placed
2.	 Click Create a copy – it should have a tick (otherwise it will move!)
3.	 Click OK
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5.4.2	 Copy created

Figure 75 – the copy has a number (2) next to it.

I now have a copy of Coffee Sales – called Coffee Sales (2) in front of the Summary sheet which is where 
I told it to go.

5.5	 Set how many worksheets you start with
If you always need more than one worksheet when starting a workbook, you can set Excel Options to 
start up a workbook with as many as you need. 

5.5.1	 Set start up options

Figure 76 – File Options

1.	 Click File
2.	 Click Options

5.5.2	 Set number of worksheets

Figure 77 – set the number of starting worksheets

1.	 Change Include this many sheets to the number you require ( I have set it to 3 sheets here)
2.	 Click OK
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5.5.3	 New workbook now has three worksheets

Figure 78

5.6	 Importing a .CSV file

In Excel 2013 you can import files from different applications and in different formats into Excel.

5.6.1	 Import a CSV file

Figure 79 – Open a .csv file in Excel

CSV stands for Comma Separated Values and is normally a list that has been created via the web or 
saved from Excel so that it can be imported into another type of program.

1.	 Click File
2.	 Click Open
3.	 Navigate to the file you wish to open
4.	 Select it 
5.	 It will open in Excel!

Note that it has a different looking icon with an ‘a’ on the image. This shows it is not a normal Excel file 
although it will open and you can work on it in Excel as normal.

http://bookboon.com/


Download free eBooks at bookboon.com

Click on the ad to read more

Excel 2013 Core: Intro

60 

Adding data


6	 Adding data
6.1	 Adding Text

6.1.1	 Adding Text

Figure 80 – click and type

1.	 Click on the cell
2.	 Type the text (1)
3.	 Press enter
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6.2	 Adding Numbers

6.2.1	 Adding numbers

Figure 81 – click and type the numbers

1.	 Click on the cell
2.	 Type the number (1)
3.	 Press enter

6.3	 Moving around a Spreadsheet

6.3.1	 Moving around using the keyboard

Figure 82 – Shortcut keys for moving around
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6.4	 Cursor Shapes (Mouse Shapes)

6.4.1	 The Cursor Shapes

Figure 83 – Mouse Shapes change depending on what you are doing
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6.5	 Selecting Data in a Worksheet

6.5.1	 Selecting A Range Of Cells

Figure 84 – click and drag to select a range

1.	 Start from the cell at the top left hand corner of the area you wish to select
2.	 Make sure that your mouse looks like the big plus sign
3.	 Click and drag over the cells you require
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6.5.2	 Selecting Columns

Figure 85 – click the column heading to select the column

Click on the Column letter you require (1)
Or
Click and drag over the column letters to select several columns (2)

Figure 86 – drag over more column headings to select more columns
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6.5.3	 Selecting areas which are not next to each other

Figure 87 – Use the Control Key to select regions not next to each other

1.	 Select the first area you require
2.	 Hold down the Ctrl key on the keyboard
3.	 Select another area keeping the Ctrl key depressed
4.	 Continue in this manner until you have selected all the areas you need

6.5.4	 Selecting the whole sheet

Figure 88 – select the whole worksheet

Click on the pale blue square at the top left corner of the spreadsheet

6.5.5	 Selecting a Row

Figure 89 – select a row

Click on the row number 
If you wish to select several rows, click and drag over the numbers, if they are not next to each other 
you can use the Control Key.
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7	 Navigating your Workbook
7.1	 Searching for data within a workbook

At Coffee Island Bill the new manager needs to find Lisa Jones in the client list.

7.1.1	 Find Information in a Worksheet

Figure 90 – find data in the worksheet

1.	 On the Home Ribbon 
2.	 Click the drop down and select Find

7.1.2	 Type in your criteria

Figure 91 – type what you are looking for

Click Find All
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Figure 92 – you can find all instances in the worksheet

The Find function has found all instances of Lisa – in both the First Name field and the email address 
fields. You can see a list of the values in the lower part of the results. As you can see from the drop down 
under Find, there are many different things you can Find in a worksheet or even a workbook. Look 
for simple text or numbers, a date, data that has been formatted in a particular way, where conditional 
formatting has been applied, even formulas.
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7.2	 Inserting hyperlinks

You can create links to other worksheets within a workbook or to an external place such as a website 
directly from within an Excel Worksheet. Hyperlinks can help you to create a menu to navigate between 
different worksheets and workbooks.

7.2.1	 Add a hyperlink to another worksheet

Figure 93 – the Insert Hyperlink icon

On the Insert Ribbon
Click Hyperlink

7.2.2	 Select where to link to

Figure 94 – set up the hyperlink in the dialog box

1.	 Select whether the hyperlink is a Place in This Document (I am linking to another worksheet)
2.	 Type the text you want the Hyperlink to display (this is what will show on the worksheet)
3.	 Type in the cell reference you want to start from on the sheet to which you have linked
4.	 Click OK
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7.2.3	 Click on the Hyperlink

Figure 95 – use the hyperlink

Simply hover the mouse over the linked text – it turns into a hand
Click and you will be taken to the location you selected

GOT-THE-ENERGY-TO-LEAD.COM
We believe that energy suppliers should be renewable, too. We are therefore looking for enthusiastic  
new colleagues with plenty of ideas who want to join RWE in changing the world. Visit us online to find  
out what we are offering and how we are working together to ensure the energy of the future.
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7.2.4	 Hyperlink to another Workbook

Figure 96 – select the workbook you wish to open

1.	 Click Insert Hyperlink as before
2.	 Select Existing File or Web Page (1)
3.	 Tell Excel where to look for the file you want to open (2)
4.	 Select the file you want to open (3)

Figure 97 – click on the hyperlink to use it

I now have a shortcut direct to the other file – you can see in the picture that the path is displayed. I can 
change the text to display as before and had just the word Shops as the link if I want.

7.2.5	 Add a Hyperlink using the keyboard

Press Control + K to open the Add Hyperlink dialogue box 
Then proceed as above

7.3	 Using Go To

Now Bob the new manager of Coffee Island needs to locate the data in a particular cell in the worksheet. 
He can use the Go To shortcut to do this. There are two ways to access Go To – via the Home Ribbon 
Find menu icon or the keyboard.
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7.3.1	 Go To via the Keyboard

Press the F5 key on your keyboard

The F-Keys are the function keys along the top of the keyboard. If you are using a laptop then they may 
have little blue white or red symbols on them. These are shortcuts and become active when you press 
the Fn key (bottom left of the keyboard.

Figure 98 – navigate around using Go To

1.	 Type the cell reference into the box
2.	 Click OK

7.3.2	 Go To with the Mouse

Figure 99 – click the icon on the Home Ribbon

1.	 On the Home Ribbon
2.	 Click Find & Select
3.	 Click Go To

You will get the same dialogue box as if you were using the Keyboard, so just type in the cell reference 
you to which you wish to jump.
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7.4	 Using the Name Box to Navigate

The Name box lives at the top of the screen underneath the Ribbon and to the left of the Formula Bar. 
The Name will always show you the cell reference of the cell your cursor is currently sitting in, and it’s 
very handy when you are looking at say row 149 and column AB. If you have scrolled that far, your 
cursor may have been left in cell A1, then when you type you will be typing in cell A1. Not great if you 
meant to type in cell AB149!

7.4.1	 The Name Box

Figure 100 – The Name Box on the left of the formula bar

Here you can see the Name Box and it shows cell B12 which is the cell where my cursor is currently sitting.

7.4.2	 Use the Name Box to Move Around

Figure 101 – type the cell you want to move to in the name box

If you know the cell reference you want to move to, you can type it into the Name box (1) and Excel 
will jump you there (2)
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8	 Workbook Views
8.1	 Introduction to Views

The Excel View options allow you to view or see the spreadsheet differently. You can adjust the Excel 
window to suit what you are currently working on by changing the view to match your current task.

Excel offers three different views:

1.	 Page Layout – displays worksheets as they would appear if you printed them out
2.	 Page Break Preview – displays the page breaks as blue lines 
3.	 Normal – the normal view for building and editing worksheets.

In addition, Excel 2013 also allows you to customize your views to include additional information to the 
view. The Full Screen view allows you to view the spreadsheet in full screen mode.
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8.2	 Normal View

8.2.1	 Normal View

Figure 102 – Normal View – no headers and footers and page breaks are dashed lines

In Normal View the spreadsheet is arranged in columns and rows and it is only possible to see the cells. 
Headers and Footers are not visible. Page breaks are only visible as dashed lines once the data has been 
viewed in Page Layout View

8.3	 Page Layout View

8.3.1	 Page Layout View

Figure 103 – see headers and footers in Page Layout View

In Page Layout View visible elements are:

1.	 Rulers – Horizontal and Vertical
2.	 Header and Footer area
3.	 Margins
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8.4	 Page Break Preview

Page break preview comes into its own when you have a lot of information on your spreadsheet and then 
when you print, you end up with a few extra rows or columns printing on a separate page. 

Using Page Break Preview you can adjust the page breaks and scale the spreadsheet so that it prints off 
on fewer sheets.

8.4.1	 To see Page Break Preview

Figure 104 – Page Break Preview from the View Ribbon

Click on the View Tab and then Page Break Preview 

OR

8.4.2	 Click the page break preview icon

Figure 105 – Page Break Preview from the Status Bar

Click the icon next to the Zoom Slider
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8.4.3	 See the Page Breaks

Figure 106 – blue lines show page breaks and they can be moved

1.	 Drag dashed lines to move rows or columns to adjacent pages
2.	 Drag the solid line to change the actual page break

What happens when I drag the dashed lines?

In effect you are scaling the text on the page and making it smaller so that it fits on to an A4 page (or 
whatever paper size you have selected)
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8.5	 Page Breaks

8.5.1	 Page Breaks

Figure 107 – Insert a Page Break

Page breaks allow you to control where one page ends and the next one starts. Excel will decide where 
the page breaks depending on how much information you have typed in and the size of the paper plus 
the margins. However, if you want to print your spreadsheet out in a particular way, you can set the 
page breaks up yourself.

A page break will be added above the cell you are in and to the left. So if you select a cell in Column A, 
the page break will be inserted above. However if you have your cursor in say Cell B4, Excel will insert 
one page break above row 4 and one to the left of column B. So be careful where you place the cursor!

With us you can 
shape the future. 
Every single day. 
For more information go to:
www.eon-career.com

Your energy shapes the future.
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8.5.2	 Apply a Background

Figure 108 – choose your background image

It is possible to format the background of your spreadsheet with an image. 

When you click the Background icon 

1)	 you can choose from the following locations to get your image:
2)	 From a file – you may want to have your logo feature as a background image – pick from file
3)	 From SharePoint – if your images are stored in SharePoint you will need to look here
4)	 Office.com Clip Art – if you really feel that you have to have a picture and you don’t have 

your own you can look here
5)	 Bing Image Search – you can trawl the internet for a suitable image – just beware of 

copyright issues
6)	 If you have a Flicker Account – you can grab an image from there
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8.6	 Creating Custom Views

You can use a custom view to save specific display settings (such as column widths, row heights, hidden 
rows and columns, cell selections, filter settings, and window settings) and print settings (such as page 
settings, margins, headers and footers, and sheet settings) for a worksheet so that you can quickly apply 
these settings to that worksheet when needed.

8.6.1	 To create a Custom View

Figure 109 – Create a custom view

1.	 On a worksheet, change the display and print settings that you want to save in a custom view.
2.	 On the View tab, in the Workbook Views group, click Custom Views (1).
3.	 Click Add.

Figure 110 – set up the view settings

4.	 In the Name box, type a name for the view (3).
5.	 Under Include in view, select the check boxes of the settings that you want to include (4).
6.	 Click OK (5)
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8.6.2	 To apply a Custom View

Figure 111 – Apply a custom view

1.	 On the View tab, click on the Custom Views button
2.	 In the dialog box, select the name of the View you want to apply
3.	 Click Show

8.6.3	 To delete a Custom View

Figure 112 – Delete a custom view

1.	 On the View tab, click on the Custom Views button
2.	 In the dialog box, select the name of the View you want to delete
3.	 Click on Delete

http://bookboon.com/


Download free eBooks at bookboon.com

Excel 2013 Core: Intro

81 

Working with Data

9	 Working with Data
9.1	 Cut, Copy and Paste

9.1.1	 Cut and Paste

Figure 113 – cut and paste

1.	 Select the cells you want to move
2.	 Go to the Home tab on the ribbon
3.	 Go to the Clipboard group
4.	 Click on the Cut icon (1) Or 

Press Ctrl-X
5.	 Place your cursor in another location
6.	 Click on the Paste icon (2)Or  

Press CTRL-V 
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9.1.2	 Copy and Paste

Figure 114 – copy and paste

1.	 Select the cells you wish to copy
2.	 Go to the Home tab on the ribbon
3.	 Go to the Clipboard group
4.	 Click on the Copy icon (1) Or 

Press Ctrl-C
5.	 Place your cursor in another location
6.	 Click on the Paste icon (2)Or 

Press CTRL-V 
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9.2	 Copying by Dragging

9.2.1	 To copy by dragging

Figure 115 – Hold control and drag

1.	 Select the cells you want to copy
2.	 Position your mouse at the border of the selection so that it changes to a cross arrow (1)
3.	 Hold down CONTROL on the keyboard
4.	 A plus sign (+) will appear next to the cross arrow
5.	 Click and drag the selection to its new location
6.	 You will see a fuzzy grey border showing you where you are going (2)

Figure 116 – note the grey border whilst dragging
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9.3	 Moving by Dragging

9.3.1	 To move by dragging

Figure 117 – position the cursor on an edge

1.	 Select the cells you want to move
2.	 Position your mouse at the border of the selection so that it changes to a cross arrow (1)
3.	 Click and drag the selection to its new location
4.	 You will see a fuzzy grey border showing you where you are going (2)

Figure 118 – drag from the edge
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9.4	 Using Paste Special

Microsoft Excel 2013 normally copies all the information in the range of cells you select when you paste 
the data. Use Excel’s Paste Special command to specify other options, such as pasting only the cell contents 
(without the formatting) or only the formatting (without the cell contents). Other options such as Paste 
Values – remove a formula and leaves just the result, and transpose which switches your data around.

9.4.1	 To use Paste Special

Figure 119 – Paste Special is great for getting different results.

1.	 Go to the Home tab on the ribbon
2.	 Go to the Clipboard group 
3.	 Click on the Paste button (1)
4.	 Select from the icon choices depending on what you wish to do Or 

Click on Paste Special (2)
5.	 Select the type of Paste Special from the dialog box (3)
6.	 Click OK

Figure 120 – the Paste Special dialog box
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9.4.2	 Which Paste Special option do I choose?

•	 All to paste all the stuff in the cell selection (formulas, formatting, you name it). This is what 
happens when you paste normally.

•	 Formulas to paste all the text, numbers, and formulas in the current cell selection without 
their formatting.

•	 Values to convert formulas in the current cell selection to their calculated values.
•	 Formats to paste only the formatting from the current cell selection, without the cell entries.
•	 Comments to paste only the notes that you attach to their cells (like electronic self-stick notes).
•	 Validation to paste only the data validation rules into the cell range that you set up with the 

Data Validation command.
•	 All Using Source Theme to paste all the information plus the cell styles applied to the cells.
•	 All Except Borders to paste all the stuff in the cell selection without copying any borders 

you use there.
•	 Column Widths to apply the column widths of the cells copied to the Clipboard to the 

columns where the cells are pasted.
•	 Formulas and Number Formats to include the number formats assigned to the pasted 

values and formulas.
•	 Values and Number Formats to convert formulas to their calculated values and include the 

number formats you assigned to all the copied or cut values.
•	 All merging conditional formats paste conditional formatting into the selected range
•	 Skip Blanks: Select this check box when you want Excel to paste only from the cells that 

aren’t empty.
•	 Transpose: Select this check box when you want Excel to change the orientation of the 

pasted entries. For example, if the original cells’ entries run down the rows of a single 
column of the worksheet, the transposed pasted entries will run across the columns of a 
single row.

•	 Paste Link: Click this button when you want to establish a link between the copies you’re 
pasting and the original entries. That way, changes to the original cells automatically update 
in the pasted copies.
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9.4.3	 Operations

When you paste, you can also perform some simple math calculations based on the value(s) in the copied 
or cut cell(s) and the value in the target cell(s):

•	 None: Excel performs no operation between the data entries you cut or copy to the 
Clipboard and the data entries in the cell range where you paste. This is the default setting.

•	 Add: Excel adds the values you cut or copy to the Clipboard to the values in the cell range 
where you paste.

•	 Subtract: Excel subtracts the values you cut or copy to the Clipboard from the values in the 
cell range where you paste.

•	 Multiply: Excel multiplies the values you cut or copy to the Clipboard by the values in the 
cell range where you paste.

•	 Divide: Excel divides the values you cut or copy to the Clipboard by the values in the cell 
range where you paste.
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9.4.4	 Transpose Columns and Rows

Figure 121 – transpose – really useful when you start your worksheet and realize it is the wrong way around

Suppose you created a table of data and then realized that you would prefer it if the data was arranged 
a different way. Excel allows you to Transpose the columns to the rows and the rows to the columns. In 
the image above I switched the data around so that the years are in the first column instead of the top 
row and the months are along the top instead of the first column.

To do this:

1.	 Select the data to transpose including the headings
2.	 Click Copy
3.	 Click into a cell where you want the data to appear (do not try and paste over the selected 

data as it will not work!)
4.	 Click the Drop down Arrow under the Paste Icon
5.	 Select the icon for Transpose or press T
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10	 Formatting Cells and Worksheets
10.1	 The Font Group

The Font group contains the main features you can use to change the appearance of your content.

10.1.1	 The Font Group

Figure 122 – The font group

1.	 Go to the Home tab on the ribbon
2.	 Go to the Font group

10.1.2	 Bold, Italic and Underline

Figure 123 – Bold Italic and underline

1.	 Select the cells you wish to format
2.	 Click on the icon you require

10.1.3	 Changing the Font

Figure 124 – the type of font

1.	 Select the cells you wish to format
2.	 Click on the down arrow next to the font box
3.	 Select the font you require
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10.1.4	 Changing the Font size

Figure 125 – change the font size

1.	 Select the cells you wish to format
2.	 Click on the down arrow next to the font size box
3.	 Select the font size you require

American LIGS University 

▶▶ enroll by June 30th, 2014 and 

▶▶ save up to $ 1,200 on the tuition!

▶▶ Interactive Online education
▶▶ study without leaving your home

▶▶ visit www.ligsuniversity.com to 
      find out more!

is currently enrolling in the
Interactive Online BBA, MBA, MSc, 

DBA and PhD  programs:

Note: LIGS University is not accredited by any 
nationally recognized accrediting agency listed 
by the US Secretary of Education. 
More info here. 

http://bookboon.com/
http://bookboon.com/count/advert/6cc05040-faa6-4cd1-8592-a34600d20a81


Download free eBooks at bookboon.com

Excel 2013 Core: Intro

91 

Formatting Cells and Worksheets

10.1.5	 Making more detailed changes

Figure 126 – see the full font dialog box here

1.	 Select the cells you wish to format
2.	 Click on the Dialog box launcher arrow on the font group
3.	 Make the changes you require
4.	 Click OK

10.2	 The Alignment Group

Alignment signifies where your text/numbers will line up in a cell.

10.2.1	 The Alignment Group

Figure 127 – Set cell alignment

1.	 Go to the Home tab on the ribbon
2.	 Go to the Alignment group
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10.2.2	 Setting the alignment in a cell

Figure 128 – 6 different ways to align text and numbers

1.	 Click on the cell
2.	 Click on the icon you need:

1.	 Top Align
2.	 Middle Align
3.	 Bottom Align
4.	 Left Align
5.	 Center Align
6.	 Right Align

10.2.3	 Orientation of text/numbers in a cell

Figure 129 – diagonal text

1.	 Click on the cell
2.	 Click on the Orientation button
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10.3	 The Number Group

Number formats allow you to change the appearance of your figures. For example, if your figures represent 
money, you can format them to appear with the pound sign and two decimal places.

10.3.1	 The number group

Figure 130 – set the formatting for numbers here

1.	 Go to the Home tab on the ribbon
2.	 Go to the Number group

10.3.2	 The number group options

Figure 131 – number format options

1.	 Number format
2.	 Currency
3.	 Percentage
4.	 Insert comma in number
5.	 Increase decimal places
6.	 Decrease decimal places
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10.3.3	 Applying number formats

Figure 132 – choose a number format

1.	 Click on the cells you want to format
2.	 Click on the Number format icon you require
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10.3.4	 Removing number formats

Figure 133 – clear a number format

1.	 Click on the cells from which you want to clear the number formats
2.	 Click on the Number Format drop down
3.	 Select the first option, General No specific format

10.4	 Wrapping Text in a Cell

Text wrapping allows you to add more text in the cell, and the cell will then keep its width but automatically 
increase its height to accommodate the content.

10.4.1	 To Wrap Text in a Cell

Figure 134 – wrap text in a cell

1.	 Select the cell you want to wrap
2.	 Go to the Alignment Group on the Home Tab
3.	 Click on Wrap Text button 
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10.5	 Format Painter

The format painter allows you to copy the formatting from one part of your workbook to another.

10.5.1	 To use the Format Painter once

Figure 135 – use format painter to copy formats from one place to another

1.	 Select the cell that contains the formatting you want to copy (1)
2.	 Click on the Format Painter button in the Clipboard group of the ribbon (2)
3.	 Click on the Cell (or Click and drag on the Cells) you want to use the formatting you have 

copied (3)

Figure 136 – with format painter switched on, you can copy formatting all over the show

10.5.2	 To use the Format Painter to copy the same format more than once

Figure 137 – double click to apply more than once

1.	 Select the text that contains the formatting you want to copy
2.	 Double Click on the Format Painter button in the Clipboard group of the ribbon
3.	 Click and drag over the text you want to use the format you have copied
4.	 Click on the Format Painter button once again to switch it off
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11	 Merge or Split Cells
11.1	 Merging Cells

Type a heading into cell A1 and if it has more than a few letters, it appears to be sitting across several 
columns. However when you click away and then place your cursor in cell B1 for example, you find that 
according to the formula bar, there is no text present.

You can merge cells together and control the alignment of the contents using the Merge Cell options.
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11.1.1	 Merge and Center

Figure 138 – Centre the heading across several cells

Select the cells you want to merge – in this case I have selected cells A1 to D1 as I would like the heading 
to be centered across them. Click on the drop down next to Merge and Center Cells.
Select Merge & Center.

Figure 139 – heading is now cantered.

The heading is now centered across the 4 cells I selected

11.2	 Merge Across

11.2.1	 Merge Across

Figure 140 – merge across leaves the alignment as it was

Merge Across merges the cells but does not center the content 
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11.2.2	 Merge Cells

Figure 141 – simply merge cells together

This option merges cells together

11.3	 Center across selection

11.3.1	 Center across selection

Figure 142 – Centre across a selection to allow calculations to work

When you merge cells together with or without centering the data, Excel treats the merged cell as one 
large cell. The issue with this is that if you need to perform calculations or sorting and filtering or any 
other programmatic function, the merged cells will get in the way.
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To get around this, you can Center Across Selection which does not merge the cells but does center 
the data.

1.	 Select the cells you wish to Center Across
2.	 Click the dialogue box launcher in the Alignment group
3.	 Select Center Across Selection for the Horizontal alignment
4.	 Click OK

11.4	 Merge Cells

The Merge Cells feature will allow you to merge cells in every direction.

11.4.1	 To get to the Merge Cells option

Figure 143 – merge any cells together

1.	 Click on the drop-down arrow next to the Merge & Center button (1)
2.	 Click on Merge Cells (2)

11.4.2	 To Merge a number of Cells

Figure 144 – any direction can be merged

1.	 Select the cells across which you would like the text to be Merged (1)
2.	 Go to the Alignment group on the Home tab of the Ribbon
3.	 Click on the drop-down arrow next to Merge and Center (2)
4.	 Click on Merge Cells (3)

Figure 145 – merged result

5.	 The cells are merged
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11.4.3	 Note: If you have content in more than one of the cells you wish to merge

Figure 146 – take care when merging cells that already have content

If you have content in more than one of the cells of your selection, the data in the upper-left cell is the 
only data that will be kept. All the other data will be lost.

11.4.4	 To Align content within the Merged cell

Figure 147 – even when merged you can control the alignment of data wihtin the merged cells

1.	 Select the Merged cell (1)
2.	 Go to the Alignment group on the Home tab of the Ribbon
3.	 Click on the Alignment option you would like (2)
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11.5	 Un merge Cells

When you wish to remove the merged formatting do the reverse process.

11.5.1	 Un merge Cells

Figure 148 – to get cells back – unmerge them

1.	 Select the Merged Cells (1)
2.	 Click on Un merge Cells (2)
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12	 Headers and Footers
12.1	 Headers and Footers

Headers and footers appear on every printed page. This is how you add page numbers, data and time, 
the file name and path and how you can add a logo to every page in the Header.

Headers and Footers are added via the Page Layout View and are typed into the Header or Footer Area 
directly. A Header and Footer Ribbon will pop up when you begin.

12.1.1	 Change to Page Layout View

Figure 149 – headers and footers can now be added in Page Layout view

Click the Page Layout Icon – bottom right of the screen.

Or

Click on the View Tab and select Page Layout View from the icons there

12.1.2	 Add a header

Figure 150 – click in to add a header

The Header (and Footer) areas are divided up into three sections, Left, Center and Right. Click into the 
area where you want your Header (or Footer) to appear.

Once there, a new Ribbon Tab Appears – Header and Footer Tools.
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12.1.3	 Header and Footer tools ribbon

Figure 151 – Header and Footer Contextual Ribbon appears when you start to add a header

This Ribbon that pops up when you click into the Header area gives you various options to add to the 
Header or Footer.

12.1.4	 Pre-set Header or Footer

Figure 152 – choose from pre – set headers/footers

Choose one of the pre-set Headers or Footers and it will be added to the Header or Footer exactly where 
your cursor currently sits 

12.1.5	 Page Number

Figure 153 – add a page number and the number of pages

There are two icons for Page Numbers, Page Number and Number of Pages. If all you need is a simple 
page number then select the first one. 
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If however you want it to show for instance Page 2 of 4 then you should:

1.	 Type the word Page
2.	 Click on the Page Number Icon
3.	 Type a space then the word of then a space
4.	 Click on the Number of Pages icon

It will then say – Page 2 of 4
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12.1.6	 Adding Header and Footer Elements

Figure 154 – header and footer elements

1.	 Current Date – adds the current date to the worksheet header/footer and will always be up 
to date

2.	 Current Time – like the current date this will always be up to date
3.	 File Path – this adds the path and name showing where the file is saved, for example C\

Documents\ExcelBook\Coffee Sales 
4.	 File Name – adds just the file name without the location
5.	 Sheet Name – adds the name of the current worksheet (assuming you have renamed it from 

Sheet 1)
6.	 Picture – allows you to add a picture to the worksheet header
7.	 Format Picture – having added a picture you can format it. This icon will only be available 

if you have a picture in the Header.

12.1.7	 Switch between Header and Footer

Figure 155 – to get to the footer from the header click Go To Footer

Click the icon that will switch you between the Header or the Footer
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12.1.7	 Options

Figure 156 – more Header/Footer options

1.	 Different First Page – if your first page is a cover, you may not want to have the same 
Header or Footer as the rest of the pages

2.	 Different Odd and Even – when printing a report, you may want to have different odd and 
even paged Headers/Footers

3.	 Scale with Document – this keeps the Header/Footer in proportion if you scale down or up.
4.	 Align with page margins – this makes sure that the Header/Footer lines up with the margin. 

If you have a narrow margin tick this box so that the Header/Footer spreads out to meet the 
margin and is not inset.

12.2	 Inserting headers and footers

Headers and footers can include valuable information about your spreadsheet, such as when it was 
printed, or the page numbers and number of pages. The easiest way to add them is to switch to Page 
Layout View where you can see the header/footer area.

12.2.1	 Switch to Page Layout View

Figure 157 – change to Page Layout View first

1.	 Click the View Ribbon
2.	 Click on Page Layout in the Workbook Views group, OR
3.	 Use the View Icons at the bottom right of the screen

Figure 158

The middle icon is Page Layout
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12.2.2	 Click into the Header section you want to use

Figure 159 – click where you would like the header to appear

Click in either the left center or right box – this will place the contents aligned the way you have chosen.

12.2.3	 The Header and Footer Tools Design Ribbon

Figure 160 – the Header and Footer Tools design Ribbon

Having clicked into the header area, you are now presented with a contextual Ribbon – Header and 
Footer Tools which in turn features the Design Ribbon. This is broken up into groups 

•	 Header and Footer
•	 Header and Footer Elements
•	 Navigation
•	 Options

12.2.4	 Header and Footer Group

Figure 161 – pre – set Headers and Footers can be selected here

Here you will find a selection of preset Headers and Footers. These will be placed across the Header or 
Footer (depending on which one you choose).
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12.2.5	 Header and Footer Elements

Figure 162 – Different Header and Footer elements

Here are the individual elements that make up the preset Headers and Footers. You can add any one of 
them alone, or a combination of them, in whichever section of the header or footer you want.

12.2.6	 Page Number (1)

Figure 163 – the Page Number field

This adds the Page Number to the worksheet as you will often have worksheets that print over several 
pages. This places a field code in the Header/Footer which means that it is always up to date and will 
change when pages are added or removed.

12.2.7	 Number of Pages (2)

Figure 164 – Page 1 of 2 will show up here

T﻿his adds the number of pages. I added the Page Number field and then typed in the word of plus the 
Number of Pages field this gives the result 1 of 2.

Figure 165 – Page 1 of 2
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12.2.8	 Current Date

Figure 166 – Add the current date

The Current Date icon places the &[Date] field into the header/footer and shows the current date.

12.2.9	 Current Time (4)

Figure 167 – add the current time

The Current Time icon places the &[Time] field in the Header/Footer and shows the current time as above.

12.2.10	 File Path (5)

Figure 168 – add the file path

The File Path places the &[File]&[Path] field into the header/footer – I am now using the Footer and it 
shows the file name and the path to the file – so you can find the spreadsheet when you need it

12.2.11	 File Name (6)

Figure 169 – show the file name

This places the name of the current file in the Header/Footer – it looks like this &[File]
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12.2.12	 Sheet Name (7)

Figure 170 – add the worksheet name

This is the name of the worksheet – it looks like this &[Tab] 

12.2.13	 Picture (8)

Figure 171 – add an image

This is used when you wish to add a picture to your Header or Footer – either as a watermark or because 
you want to add a logo in the top right as in the image above.

12.2.14	 Format Picture (9)

Figure 172 – picture formatting tools appear when you have a picture

This button only becomes available when you have a picture in your Header/Footer 
Use it to change the size, crop, change brightness etc.
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13	 Printing Headings
13.1	 Print Titles

This is a very handy feature. There are times when you may have a very long list and you would like 
the header to print on every page. You know, you print the list out and on pages 2,3,4 etc it becomes 
impossible to see what the columns are. Enter Print Titles.

Get “Bookboon’s Free Media Advice” 
Email kbm@bookboon.com

See the light! 
The sooner you realize we are right, 
the sooner your life will get better!

A bit over the top? Yes we know! 

We are just that sure that we can make your  
media activities more effective.
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13.1.1	 Print Titles

Figure 173 – Print your titles on every page

1.	 Click on Print Titles
2.	 Click into Rows to repeat at top
3.	 If you want to repeat a column or two select them as well in Columns to repeat at left
4.	 Click OK

Figure 174 – see column headings print

Here on Page 2 you can see the Column Headers are showing in Print Preview
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13.2	 Print Columns to Repeat with Titles

Just like printing the header row on each page, you may wish to print the first column on every page too.

Figure 175 – print the first column on every page

1.	 Click on Print Titles
2.	 Click into Columns to Repeat at left
3.	 Select the column you wish to print

Now the column you selected will be printed on every page.
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14	� Hide and Unhide Rows 
and Columns

14.1	 Hiding Columns

Just like worksheets, there are times when you may wish to hide Columns or Rows. In the Coffee Island 
Price List example, I have now worked out the Sales Price and want to show this to someone. I don’t want 
them to see the columns with the Profit Margin or the Cost Price. My aim is to use the one worksheet 
to show them just the Drink and the Sales Price
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14.1.1	 Hide Columns

Figure 176 – Right click to hide columns

1.	 Select the columns you want to hide – in my case B and C
2.	 Right click 
3.	 Click on Hide

14.1.2	 Columns are now hidden

Figure 177 – hidden columns – the letters are missing

Notice that I now have column A followed by D – B & C have been hidden.
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14.2	 Un hide Columns

14.2.1	 Un hide Columns

Figure 178- right click to un hide columns

1.	 Select columns – here I selected A & D
2.	 Right click
3.	 Choose Un hide

Figure 179 – columns return

The columns are now back!
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14.3	 Hiding Rows

In the same way that I can hide a column I can also hide a row or several rows.

14.3.1	 Hide a Row or Rows

Figure 180 – hide rows

1.	 Select the Row(s) you wish to hide
2.	 Right Click
3.	 Select Hide

14.3.2	 Rows are hidden

Figure 181 – row numbers are hidden too

Rows 3 and 4 have been hidden.

http://bookboon.com/


Download free eBooks at bookboon.com

Excel 2013 Core: Intro

119 

Printing Headings

14.4	 Unhide Rows

14.4.1	 Unhide Rows

Figure 182 – right click to unhide rows

1.	 Select the rows either side of the ones you wish to un-hide
2.	 Right Click
3.	 Select Un-hide

14.4.2	 Rows are unhidden

Figure 183 – here they are again
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15	� Page Setup Options 
for Worksheets

15.1	 Page Orientation

15.1.1	 Page Orientation

Figure 184 – change orientation

To change from Portrait to Landscape click the drop down and pick the setting you need.
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15.2	 Modifying page setup

We can change the way the page is set up. You might want different margins or to change from Portrait 
to Landscape.

15.2.1	 The Page Layout Ribbon

Figure 185 – Page Layout Ribbon

This is where you will come to change different aspects of the spreadsheet layout.

1.	 Themes – this is where you can change the colour scheme and fonts for the whole work book
2.	 Page Setup – here you will change Margins, Orientation, Paper Size, Set Print Area, Add 

Page Breaks, format the background and set up Print Titles
3.	 Scale to fit – you can change the width or height of the page and scale it up and down to 

make the contents fit on the printed page
4.	 Sheet Options – View grid lines, View and/or Print Grid lines, View and/or Print Headings
5.	 Arrange – if you have added graphics to the worksheet you can arrange how they behave on 

the page here.

15.3	 Change the Margins

15.3.1	 Change the Margins

Figure 186 – choose pre – set margins or set your own

Click the drop down underneath Change Margins and select one of the presets. If you wish to set your 
own measurements for the margins, click on Custom Margins.
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15.3.2	 Custom Margins

Figure 187 – set your own margins

Set the exact measurements you want for the Top, Left, Right and Bottom margins.
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15.4	 Changing the Header and Footer Size

15.4.1	 To change the Header and Footer size

Figure 188 – access custom margins

1.	 Go to the Page Layout tab on the ribbon
2.	 Go to the Page Setup group
3.	 Click on Margins (1)
4.	 Click on Custom Margins... (2)

Figure 189 – set the header and footer margins here

5.	 Either type or use the up and down arrows to set the Header and Footer sizes
6.	 Click OK
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15.5	 Setting Print Scaling

Scaling your worksheet allows you to make all the data you have fit on one piece of paper, or as many 
as you specify. The upside is you get all your data on one sheet of paper, the downside is the text size 
will shrink and you might need a magnifying glass to read the spreadsheet.

15.5.1	 The Scale to fit group

Figure 190 – you can open the dialog box to get more options

Here you can try out different scaling options, simply change the percentages in the boxes and see how 
your spreadsheet looks. To see how it will print, hop into Page Break Preview or click File and then 
Print to see the preview. You can set the scale to a total percentage here. If you would like more detail 
you can click on the dialogue box launcher at the bottom right of the group. 

15.5.2	 Scale to fit dialogue box

Figure 191 – scale the content to fit on a page

Click the dialogue box launcher.

In the Scaling group of settings you can tell Excel to make the data fit to 1 page wide by 1 page high or 
any combination you want.
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16	 Print a Worksheet or a Workbook
16.1	 Printing

Setting up your workbook to print is really simple. Add the print icon to the Quick Access Toolbar, or 
use the Print Menu or even the keyboard shortcut to print.

16.1.1	 What do I see when I click Print?

Figure 192 – the Print dialog

1.	 The Print Icon – click this to send your spreadsheet to the printer
2.	 Number of Copies – change how many printed copies you want
3.	 Select the printer to send the job to – in my case I have my laser printer selected but it 

could easily be the colour printer too
4.	 Select which sheets to print
5.	 If you have lots of data that will print on many sheets of paper, you can decide which pages 

you wish to print
6.	 If you have several pages, do you want them collated or not? If you are printing more than 

one copy of a spreadsheet with several pages consider selecting Collated
7.	 If you forgot to change the Orientation from Portrait to Landscape before coming to Print, 

you can change it here
8.	 Change the paper size here
9.	 Forgot to change the margins? Or perhaps the preview does not look quite right, you can 

change the margins directly from here
10.	 Set up scaling options here too
11.	 Go to Page Setup – if you want to make lots of changes at once you can access Page Setup 

from here
12.	 The Preview – Print Preview has been combined with Print so you can see exactly how it 

will look 
13.	 Tells you how many pages there are and which one you are looking at.
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16.2	 Printing individual worksheets

When it comes to printing in Excel there are several ways to print your data. You may wish to print just 
a selection of data, the current active worksheet or the entire workbook. Here is how to print just the 
active worksheet.

16.2.1	 Print Active Worksheet

Figure 193 – print the worksheet you are looking at

1.	 Click File
2.	 Set the number of copies you want
3.	 Click Print

Note that in the Settings area it says Print Active Sheets.
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16.2.2	 To change the print settings

Figure 194 – change print settings

Click the drop down list next to Print Active Sheets and make your selection

Print Active Sheets – this prints all the data on the current worksheet

Print Entire Workbook – this prints ALL worksheets in the current workbook

Print Selection – this prints only those cells which you have selected prior to clicking on File >Print

Ignore Print Area – If you have set a Print Area you may wish to now print the entire worksheet or a 
different selection of data, by ticking the Ignore Print Area instruction, Excel will ignore your Print Area 
settings and they will be there for next time.

Ensure your next performance management 
meetings run like a dream! Full trial FREE for 10 staff.

LEAD WITH 
CLARITY AND 
CERTAINTY

A short cut for managers to 

the most effective personal 

development plans and 

information that will quickly 

boost employee motivation, 

performance and results.

GET MY FREE TRIAL

Amy, let’s just 
discuss these action 

points
Spot on - I’m all 

fired up!! Looking 
forward to next 

quarter

Can’t believe 
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5 minutes
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a review with Performance Review Pro
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17	 Cell Styles
17.1	 Apply Cell Styles

Cell styles are pre-set formats for cells. They can be reused to help your sheet’s formatting look consistent.

17.1.1	 To apply a cell style

Figure 195 – cell styles help make a worksheet readable

1.	 Select the cells you would like to apply a style to (1)
2.	 Go to the Styles group on the Home tab on the ribbon
3.	 Click on the Cell Styles button (2)
4.	 Click on the style you would like to apply (3)
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17.2	 Create Cell Styles

You can create your own Cell Style to allow you to rapidly format your workbook consistently.

17.2.1	 To create a cell style

Figure 196 – you can create your own cell styles

1.	 Format a cell/some cells in the style you would like to add to Cell Styles (1)
2.	 Go to the Styles group on the Home tab on the ribbon
3.	 Click on the Cell Styles button (2)
4.	 Click on New Cell Style (3)

Figure 197 – set the options you want

5.	 Give the style a name (4)
6.	 Un-check any boxes that relate to styles you do not want to keep (5)
7.	 Click OK
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If you want to change anything on the style before confirming, click on the Format button to bring up 
further options (6)

Figure 198 – your new styles appear here

8.	 Your custom style appears in the Cell Styles drop down menu under “Custom” (7)

Contact us to hear more 
kbm@bookboon.com

Do your employees receive 
the right training?
Bookboon offers an eLibrairy with a wide range of 
Soft Skill training & Microsoft Office books to keep 
your staff up to date at all times.
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18	 Autofill
18.1	 Copy Data using Autofill

Auto Fill is a time saving feature that allows you to copy text, numbers or Formula in a spreadsheet.

18.1.1	 To copy data using auto fill

Figure 199 – use the little black plus sign

1.	 Type your content into your first cell.
2.	 Position your cursor so it hovers over the bottom right of the cell and it turns into a black 

cross (1)

Figure 200 – drag

3.	 Click and drag horizontally or vertically to copy the content

Figure 201 – content copied

4.	 When you let go, the content is copied 
If the content contains figures (or a possible series e.g. 1,2,3 or Monday, Tuesday, Wednesday)

5.	 A Smart Tag appears (1)
6.	 Click on the drop down arrow on the Smart Tag

Figure 202 – smart tags give further options

7.	 Select Copy Cells from the Smart Tag options
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18.1.2	 Fill Series using Autofill

Auto Fill is a time saving feature that allows you to copy text, numbers or Formula in a spreadsheet.

18.1.3	 To Fill Series data using auto fill

Figure 203 – autofill can create a series too

1.	 Type your content into your first cell.
2.	 Position your cursor so it hovers over the bottom right of the cell and it turns into a black 

cross (1)

Figure 204 – click and drag the little black plus
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3.	 Click and drag horizontally or vertically to copy the content

Figure 205 – click on the smart tag to change options

4.	 When you let go, the content is copied but each cell is incremented from the cell before (e.g. 
1, 2, 3 or Monday, Tuesday, Wednesday)

Optional: Smart Tag

5.	 A Smart Tag appears (1)
6.	 Click on the drop down arrow on the Smart Tag

Figure 206 – select your options

7.	 Select as appropriate from the Smart Tag options

18.1.4	 Special Lists

Figure 207 – days of the week, months – special lists

Special Lists are regularly used items that have been pre-set by Microsoft. For example, you can auto fill 
days of the week, months of the year and dates.

18.1.5	 To auto fill a special list

1.	 Type the first item of the special list
2.	 Auto fill as usual, horizontally or vertically
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18.2	 Copy Formatting using Autofill

Auto Fill also allows you to copy formats from one cell to another.

18.2.1	 To copy formatting using auto fill

Figure 208 – set your format

1.	 Format the content in your first cell.
2.	 Position your cursor so it hovers over the bottom right of the cell and it turns into a black 

cross (1)

Figure 209 – click and drag

3.	 Click and drag horizontally or vertically to copy – initially it will also perform a content auto 
fill so may overwrite the content already in the cells. Don’t panic, this is only temporary!

Figure 210 – content and formatting is copied

4.	 When you let go, the content is copied but, more importantly, the formatting is also copied.
5.	 A Smart Tag appears (2)
6.	 Click on the drop down arrow on the Smart Tag

Figure 211 – select fill formatting if that is all you require
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7.	 Select Fill Formatting Only from the Smart Tag options

Figure 212 – formatting is copied

8.	 The content returns to its previous values, but the formatting is copied across

18.2.2	 To fill without copying the formatting

Sometimes you might want to auto fill from a cell that is already formatting, in which case the formatting 
will also be copied.

To prevent the formatting being copied, auto fill as usual, then select Fill WIthout Formatting from the 
Smart Tag options.
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19	 Flash Fill
19.1	 Flash Fill

Flash Fill is a brand new feature. When you have data in a column and want to extract something or 
copy something, previously you would have used a formula. Excel 2013 will now do the heavy lifting 
for you. In fact at first when you see how it works, you might have wondered what on earth Excel was 
playing at and dismissed what is in fact a real time saver.

19.1.1	 Flash Fill to Join Two Columns

Figure 213 – use Flash Fill to connect content from two columns

In my example, I have a spreadsheet with names which have been entered as First Name and Last Name. 
I actually need to have a Full Name field. This can easily be achieved with a formula however most 
people don’t really like writing formula and you may want to strip out the formula once you achieved 
the result. This is yet another step.

Enter Flash Fill:

1.	 Type the result you want in the first cell
2.	 Type the result you want in the second cell so Flash Fill gets to really work out what you 

are doing
3.	 You will see the grey suggestions
4.	 If you like what you see simply press the Enter key and that’s it!
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19.1.2	 Flash Fill to Extract Data

Figure 214 – extract data from a list

I want to have the postcode in a separate column. 

The process:

1.	 Type a heading and format it in the first cell (E1 in my example)
2.	 Type the first Postcode in the list 
3.	 Start to type the second Postcode
4.	 Excel now finds the pattern in what you are doing and Flash Fills the rest of the column!
5.	 Press Enter to accept.

19.1.2	 Flash Fill to Format Telephone Numbers

Figure 215 – you can even reformat data

I received this spreadsheet with telephone numbers typed in the Number Column without any spaces 
or hyphens. I would like the numbers to have hyphens in between each block of numbers.

1.	 Format the cells as Text – this makes sure that any leading 0 stays put and does not get dropped
2.	 Format the cells in the next column as text too
3.	 Type in the first telephone number in the format you want to use
4.	 Start to type the second one
5.	 The Flash Fill suggestions will appear
6.	 Click Enter to accept
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20	 Formulas
20.1	 Formulas Introduction

A Formula is the term used for a calculation in your spreadsheet. 

A formula performs calculations or other actions on the data in your worksheet. A formula always starts 
with an equal sign (=), which can be followed by numbers, mathematical operators (such as a plus or 
minus sign), and functions, which can really expand the power of a formula.

For example, the following formula multiplies 2 by 3 and then adds 5 to that result to come up with the 
answer, 11.

=2*3+5
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20.1.1	 How is a formula made up?

Figure 216 – syntax of a formula

•	 Formula always start with the equals sign
•	 Cell references are used instead of numbers
•	 A mathematical symbol is used to denote the type of calculation

20.1.2	 Best practice: Using cell references in formulas

While this formula works, it has one drawback. If you want to change the data being calculated you 
need to edit or rewrite the formula.

A better way would be to write formulas so that you can change the data without having to change the 
formulas themselves. To do this, you need to tell Excel which cell the data is located in. 

A cell’s location in the spreadsheet is referred to as its cell reference.

To find a cell reference, simply look at the column headings to find which column the cell is in, and 
across to find which row it is in.

The cell reference is a combination of the column letter and row number -- such as A1, B3, or Z345. 

When writing cell references the column letter always comes first.

So, instead of writing this formula in cell C1:
= 3 + 2

write this instead:
= A1+A2
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21	 Create Formulas
21.1	 Add, Subtract, Multiply, Divide

The structure of a basic formula in Excel always follows the same structure:

•	 Equals Sign
•	 First Cell Reference
•	 Mathematical Symbol
•	 Second Cell Reference

Figure 217 – breakdown of a formula
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21.1.1	 The Mathematical Symbols used by Excel

+ Addition

- Subtraction

* Multiplication

/ Division

21.1.2	 To create a formula to add, subtract, multiply or divide

Figure 218 – build your formula

1.	 Click on the cell where you require the answer
2.	 Type the = sign
3.	 Click on the first cell involved in your calculation
4.	 Type the maths symbol you are using
5.	 Click on the next cell involved in your calculation
6.	 Repeat steps 4 & 5 (if you need to add more cells to your formula)
7.	 Press Enter

Figure 219 – here is the result

8.	 The cell will then show the result of the formula

21.1.3	 Make Changes to Formulas in a Cell

To change a formula in a cell, double click on the cell and the formula will be revealed for you to edit 
as you wish.
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21.2	 Make Changes to Formulas in the Formula Bar

When you select a cell that contains a formula, the cell displays the result of the formula but the formula 
can be seen in the formula bar.

Figure 220 – click into the formula bar to make changes

21.2.1	 To make changes to formula in the formula bar

1.	 Select the cell containing the formula you want to change
2.	 Click into the formula bar and make the changes you require
3.	 Press enter on the keyboard

21.3	 Using Autofill to Copy Formulas

If you have a table of data that all use the same calculation, it would be tedious to manually enter the 
formula again and again. So you can copy a formula using Auto fill.

To copy a formula using auto fill

Figure 221 – create the first formula

1.	 Create your first formula
2.	 Select the cell
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3.	 Hover your cursor over the bottom right hand corner of the cell until you get the black  
cross (1)

Figure 222 – click and drag

4.	 Click and drag in the direction you want to Auto fill

Figure 223 – formula magic

5.	 The formula is copied down and the results appear in the cells
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22	 Enforce Precedence
22.1	 Order of Evaluation (Order of Precedence) (BODMAS)

Calculations are not simply done from left to right. Below is the order in which all calculations are 
performed.

Figure 224 – in maths there is a certain order of precedence
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By sharing our experience, expertise, and creativity, 
industries can boost performance beyond expectations. 
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The acronym for this is BODMAS

Brackets Order Divide Multiply Add Subtract

So, for example, if I had the calculation:

=2+3*4

There are two possible solutions. If I add 2+3 and then multiply by 4 I would get an answer of 20.

However in Excel the multiplication would be done first, because multiplication has higher priority than 
addition. So Excel would calculate the formula as:

3 multiplied by 4 and then add 2, to get an answer of 14.

22.1.1	 To get Excel to calculate a formula in the order you would like it to

To get around the order of precedence, use brackets to separate the calculation you would like to be 
done first.

So in the example:

=2+3*4

If I want the 2+3 to be done before the multiplication by 4, I put brackets around the 2+3

=(2+3)*4

This way, Excel will calculate the formula in the order I want it to, rather than by following the Order 
of Evaluation.
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23	 Absolute Cell References
23.1	 Absolute Cell References

Using Auto Fill to copy formulas is a great way to save time, but the cell references in the original 
formula do not always need to be adjusted. There are some situations where a cell reference needs to 
remain constant. 

For example:

Look at the spreadsheet shown below – everyone’s salary is due to increase by 10%. The first formula, 
to find Shing Chen’s new salary has been created. His current salary (in Cell B4) has been multiplied 
by the value in Cell B1, 10%.

Figure 225 – create the first formula

With us you can 
shape the future. 
Every single day. 
For more information go to:
www.eon-career.com

Your energy shapes the future.
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The quickest way to work out everyone else’s increase is to copy Shing Chen’s formula. However, if 
the formula is copied using Auto Fill as it is, the row numbers will be incremented, including the cell 
reference for the 10% increase, and we’ll end up with some funny answers...

Figure 226 – it all goes horribly wrong at first

Here, Auto Fill has caused the row numbers to be adjusted. But the formula we need requires Cell B1 
to remain constant even when Auto Fill is used. 

Excel must absolutely always look at this cell. In other words, we need to make it an absolute cell reference. 

Figure 227 – Absolute or fixed cell references

23.2	 How to Create an Absolute Cell Reference

23.2.1	 To input an absolute cell reference while creating a formula

Figure 228 – use dollar signs to f﻿ix the cell reference

1.	 Select the cell where you require the first formula
2.	 Enter the formula as normal
3.	 Press F4 after the cell reference you wish to be absolute (Dollar signs will appear around the 

cell reference) 
4.	 Press Enter
5.	 Auto Fill the formula
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23.2.2	 To change an existing formula that needs an absolute cell reference

1.	 Click on the cell containing the formula you wish to change
2.	 Double-click on the cell (or Click next to the formula on the Formula bar)
3.	 Move the cursor so that it sits next to the cell reference you wish to make absolute
4.	 Press F4
5.	 Dollar signs will appear around the cell reference
6.	 Press Enter

23.3	 Relative Cell References

An absolute cell reference is useful if you have one cell that needs to be completely fixed, but sometimes 
you need to only fix part of a cell reference.

This is known as a relative (or partial absolute) cell reference.

23.3.1	 Glossary of Relative Cell References

$A1 Allows the row reference to change, but not the column reference

A$1 Allows the column reference to change, but not the row reference

$A$1 Allows neither the column nor the row reference to change

23.3.2	 To add a Relative Cell Reference (Partial Absolute)

1.	 Type your formula
2.	 Place your cursor next to the reference you want to make a Partial Absolute
3.	 Press F4 on the keyboard – the cell becomes Absolute (e.g. $A$1)
4.	 Press F4 again – the reference becomes a Partial Absolute fixing the row (e.g. A$1)
5.	 Press F4 again – the reference becomes a Partial Absolute fixing the column 
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24	 Basic Functions
24.1	 Basic Functions

There are certain useful calculations that become long winded if you try and create them with 
straightforward formula.

For example, a calculation such as finding the Average of a group of numbers could be complicated to 
write if you were to work it out for yourself.

Similarly, if you have 300 items that you want to add up, it would be tedious to write a long formula 
with 300 calculations.

So Excel has the ability to use functions. These are specially programmed formulas that allow you to 
perform these more complicated calculations much more easily.

TMP PRODUCTION NY026057B

PSTANKIE

gl/rv/rv/baf

ACCCTR0005

Bookboon Ad Creative

4

6 x 4

12/13/2013

Bring your talent and passion to a
global organization at the forefront of
business, technology and innovation.
Discover how great you can be. 

Visit accenture.com/bookboon

©
2013 Accenture. 

All rights reserved.

http://bookboon.com/
http://bookboon.com/count/advert/d3e11eac-cdd1-4cf4-a3e9-a297008c92ae


Download free eBooks at bookboon.com

Excel 2013 Core: Intro

150 

Basic Functions

24.1.1	 The structure of a basic function

Figure 229 – structure of a function

Because functions are so varied, the details of their construction are unique. But they all follow a similar 
basic structure. 

They begin with an Equals sign (1), followed by the Name of the Function (2), then the details of the 
function in Brackets (3)

The content between the brackets will be different depending on the Function being used.

24.2	 Using Basic functions via the Auto sum Button

The Auto Sum button contains five commonly used basic functions. These are SUM, AVERAGE, MAX, 
MIN and COUNT

24.2.1	 SUM, AVERAGE, MAX, MIN and COUNT

Figure 230 – basic functions on the AutoSum icon
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24.2.2	 To use a basic function using the Auto sum button

Figure 231 – use a function

1.	 Click on the cell where you require the answer (1)
2.	 Go to the Editing group on the Home tab on the ribbon
3.	 Click on the Auto Sum drop down button (2)
4.	 Select the function you require

Figure 232 – Excel works its magic

5.	 The cells Excel thinks you want to calculate will be highlighted and the Function will appear 
in the cell. If Excel hasn’t selected the cells you want, click and drag over the ones you do 
want to include

6.	 Press Enter
7.	 The answer will be shown in the cell
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25	� Managing Worksheets 
and Workbooks

25.1	 Introduction Worksheets

Excel files are called workbooks and just like any book they can contain several worksheets. 

To begin with you will have just one worksheet, but you can add as many as you need.

25.1.1	 Why have more than one sheet?

Imagine that you have to store information about your organization’s budget over five years. If you try 
and put all this onto one sheet, it will become so vast that it will be almost impossible to navigate through 
and find the information that you require. If you set up similar sheets for each year or even for each 
month, then it becomes a lot easier to find the information you are looking for.
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26	 Create and format worksheets
26.1	 Adding worksheets to existing workbooks

Sometimes you will find that you need more worksheets than are available in the workbook. Perhaps 
you are creating a summary worksheet or you want to keep track of different things on different sheets.

In Excel 2013 it is very simple to add a new worksheet to the workbook – here is how.

26.1.1	 Add a new worksheet

Figure 233 – new worksheet button

Click on the plus sign next to Sheet1 and you will get a new worksheet.

26.1.2	 New worksheet added

Figure 234 – new worksheet added

Keep adding sheet tabs until you have as many as you need.

26.2	 Delete Worksheets

Figure 235 – simple to delete a worksheet

The easiest way is to Right Click on the sheet tab and select Delete
The worksheet is deleted immediately.
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26.3	 Copying and moving worksheets

When working on the structure of your workbook, you may realize that you need another copy of a 
particular worksheet in the same workbook or you might want to move or copy the worksheet to another 
location in the workbook or even to another workbook entirely.

26.3.1	 Move a worksheet within the workbook

Figure 236 – click and drag to move

Click and drag on the sheet tab to move it – you will see a little image of a page – drag this to the location 
you wish to place it
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26.3.2	 The worksheet has moved

Figure 237 – it moved

26.3.3	 Copy a worksheet within the workbook

Figure 238 – right click to copy

1.	 Right click on the worksheet tab
2.	 Select Move or Copy Sheet
3.	 Tick Create a copy 
4.	 Select where you want to place the copy
5.	 Click OK

26.4	 Rename a Worksheet

You can name the worksheets to make your work more meaningful. Instead of Sheet 1, Sheet 2, Sheet 3 
you can have January, February, March or whatever name you wish.

26.4.1	 Rename a Worksheet

Figure 239 – double click to rename

Double click on the sheet tab to highlight the current name (in this case Sheet2)

Figure 240 – name changed

Type your name and then click away to confirm.
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26.5	 Grouping Worksheets

When sheets are grouped together, whatever you do on one sheet will “burn through” to all of the other 
sheets in the group. It’s useful when you are going to have several sheets in a workbook that do virtually 
the same thing. For instance, you might be creating a budget over several months, and each month has 
its own sheet. With sheets grouped you can:-

•	 Apply formatting to all of the sheets in the group at once
•	 Create formula on all of the sheets in the group at once

26.5.1	 To group worksheets that are next to each other

Figure 241 – group with the shift key

1.	 Click on the first Sheet tab that you require
2.	 Hold down the Shift key
3.	 Click on the last Sheet tab that you require
4.	 The Sheet Tabs of the sheets that are grouped will turn white

26.5.2	 To group worksheets that are not next to each other

Figure 242 – group with the Control Key

1.	 Click on the first Sheet tab that you require
2.	 Hold down the Control key
3.	 Click on any other Sheet tabs that you require
4.	 The Sheet Tabs of the sheets that are grouped will turn white
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26.6	 Changing worksheet tab colour

When you have many worksheets, it can be helpful to change the tab colour so that the one you want 
is easy to recognize.

26.6.1	 Change tab colour

Figure 243 – change the tab colour

1.	 Right Click the Worksheet tab
2.	 Click on Tab Colour
3.	 Choose the colour from the colour palette 

Figure 244 – different coloured tabs help identify worksheets

Worksheets are now colour coded!

26.7	 Hiding worksheets

At times you may wish to hide an entire worksheet in a workbook. For example at Coffee Island we are 
working out the sales price of the various drinks we sell. Multiply the cost price by the profit margin 
and then add up the total price that we sell the coffee for.

When showing this workbook to a customer for example, we might not want them to see the percentages 
on the Variables worksheet. So this worksheet can be hidden. Any calculations will still work, the data 
will simply be hidden from view.
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26.7.1	 Hide a worksheet

Figure 245 – right click and choose hide

1.	 Right click on the tab of the worksheet you wish to hide
2.	 Select hide

Figure 246 – worksheet hidden

We now only have two worksheets

Free online Magazines
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26.7.2	 To Unhide the worksheet

Figure 247 – right click the tab

1.	 Right click on a worksheet tab
2.	 Select Unhide

Figure 248 – choose the worksheet to unhide

Click on the worksheet you want to unhide

Click OK

Figure 249 – worksheet displayed

The worksheet is now unhidden.
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26.8	 Sum across Worksheets

When you have a workbook with several worksheets you will need to sum across sheets. When data is 
dispersed use the simple way of creating a formula however if you have created a workbook with the 
same structure on each worksheet, you can sum across all the sheets at the same time.

26.8.1	 Add Up Data from more than one Worksheet

Figure 250 – sum across worksheets

1.	 Click in the Summary worksheet where you want the answer – in this example cell B6
2.	 Type an = to signal to Excel that you are going to calculate
3.	 Click on the Sheet tab called January 
4.	 Click into cell B6 on the January Worksheet
5.	 Press the + sign
6.	 Click on the February Worksheet
7.	 Click on Cell B6 on the February Worksheet
8.	 Press the + sign
9.	 Click on March

10.	 Click on Cell B6 on the March Worksheet
11.	 Press Enter

Note the formula =January!B6+February!B6+March!B6

The ! after the sheet tab name indicates to Excel to refer to the sheet of that name.

Just keep on adding cells until you have everything you need.
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26.8.2	 Sum across sheets when the structure is the same

Figure 251 – where the data is in the same cell location use this method

This time because we created a workbook with a bunch of worksheet with the same structure, we can 
use a Sum together with Grouping the sheets to add them all up.

The formula here tells Excel to go to the Worksheets January through March and add up the contents 
of Cell B6.

1.	 Click into the cell where the answer will go
2.	 Type =Sum(
3.	 Now you need to group the other worksheets, so click first on January then hold down the 

Shift Key and click on March – this groups all worksheets between January and March
4.	 Then click on Cell B6
5.	 Close the Brackets and press Enter
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27	 Manipulate window views
27.1	 Splitting the window

At times you may be working on a huge worksheet. It can be very time consuming and tedious to scroll 
up and down and right to left to work on different parts. When you Split the worksheet into Panes, you 
can scroll them independently and work on them, and still be in the same worksheet.
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SMS from your computer
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27.1.1	 Split a worksheet

Figure 252 – split a worksheet to work on two parts simultaneously

1.	 Click into the worksheet where you want to split the worksheet
2.	 Click on the View tab
3.	 Click the Split button

The worksheet will split above and to the left of where your cursor is.

27.1.2	 Scroll in different parts

Figure 253 – scroll up and down in both parts of the window

You can now scroll in the top or the bottom half
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27.1.3	 Remove the split

Figure 254 – remove the split

1.	 Click on the View tab
2.	 Click on Split

The split will now disappear.

27.2	 Open Two Copies of the Same Workbook

When working on a workbook that contains many worksheets, there are times that you need to see two 
worksheets at the same time. Imagine that you have a summary worksheet and you need to see the effect 
of making a change on one of the spreadsheets that feed into it. 

You can open a second copy of the workbook in a new window and then arrange the windows side by 
side so that you can see the January worksheet in one window and the Summary worksheet in the other. 
Now whenever you make a change to the January worksheet you will be able to see the effect on the 
Summary. I have to say that this is one of my favorite features.

27.2.1	 Create a Second Window in the Same Workbook

Figure 255 – first copy

Here is my workbook – it is called Summary Workbook – Excel (1)
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Click on New Window (2)

Figure 256 – second copy

I now have Summary Workbook2 – Excel (3)
Click on Arrange All (4)
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27.2.2	 Arrange the Workbooks

Figure 257 – decide how to display the workbooks

Now select the way you wish to see the worksheets arranged. I have selected Vertical

Click OK

27.2.3	 Two copies side by side

Figure 258 – here are my two copies side by side

Now I have two copies of the same workbook open, Summary Workbook:1 – (1) and Summary 
Workbook:2 (2)

In one I have the January worksheet open (3), and in the other I have the Summary Worksheet open (4)

Now any changes that I make to January will show in Summary.
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Figure 259 – change is reflected in both

As you can see in the screen shot above, I changed the total sales of Cappuccino in January to 500 and 
the Summary sheet total changed too.
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